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Exercise 11 - AGCHEM
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Questions addressed in this exercise:
1) Where can | view nutrient modeling output from AGCHEM?
2) How do I interpret output files and summary reports?
3) What are some important nutrient loss processes with respect to agricultural land?
4) Which parameters are important for modeling plant uptake?
5) What are some important nutrient sources with respect to agricultural land?
6) Which parameters are important for modeling mineralization?
7) How can | adjust the amount of atmospheric deposition in my model?

Pesticide, nitrogen, and phosphorus compounds are important to agricultural production.
Prediction of their removal from fields is necessary for wise management of both land and
water resources. HSPF can be used to predict loads from different land uses given various
land management practices. The agri-chemical (AGCHEM) sections of the PERLND module
of HSPF simulate detailed nutrient and pesticide processes, both biological and chemical,
and the movement of any nonreactive tracer in a land segment. These chemicals can also be
simulated in module section PQUAL, but in a simplified manner. The dynamic and
continuous processes that affect the storages and outflow of pesticides and nutrients from
fertilized fields should often be simulated in detail to fully analyze agricultural runoff. This
is especially important if there is a need to evaluate impacts of chemical and nutrient
applications, nutrient management alternatives, and other agricultural or forestry practices.
The AGCHEM section allows representation of a complete nutrient/chemical balance
approach as the foundation for modeling soil processes. If the situation does not require full
representation of these processes nor of nutrient balances, or if sufficient data are not
available, the PQUAL subroutines can be used (HSPF Manual, 2001).

In modeling nutrients with AGCHEM, there are two important components of the nutrient
balance that must be considered: (1) sources such as mineralization, atmospheric deposition,
and fertilizer application, and (2) losses such as plant uptake and immobilization. These
sources and losses are represented in terms of “plant available’ nutrients, which are primarily
the inorganic forms, i.e. NO3, NH3, POj.

In this exercise, we will gain a better understanding of how AGCHEM works by adjusting

key parameters, running various scenario simulations, and ascertaining the effects of our
adjustments by examining output files, plots, and summary reports.
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A. AGCHEM Output and Reports

QUESTIONS ANSWERED:
1) Where can | view nutrient modeling output from AGCHEM?
2) How do I interpret output files and summary reports?

1. Using Windows Explorer or My Computer, navigate to c:\basins\modelout\agchem.
Double click “wb_agchm2.out.” View the file in WordPad or Notepad. Your screen
should look like the following:

File Edit Wew Insert Format Help
D[c(e| Sal ] b meo] )|
ALIR TEMPERATUREZ (DEG F| GAGE SEGHMENT
EXTNL INFLOUS & OUTFLOUS MOISTURE<————— OUTFLOWS TO STREAM-————————- »(SUM) DEEP PERC
2. Look through the file. Try to determine the answers to the following questions:
a. How much total Nitrogen was applied to PERLND 310 in 19867
b. What were the components of this application?
c. How much total nitrogen plant uptake was there in PERLND 310?
d. How much nitrogen plant uptake was there in the upper zone?
e. How much total nitrogen is stored in the soil in PERLND 310 at the end of 1996?
f.  How much mineralization of nitrogen occurred in 1986 in PERLND 310?
g. Which soil layer had the largest amount of mineralized nitrogen?
Question Answer Answer Location
A 133.16 Ibsfac NITR - Applications: Nitrogen All Forms
Ammonia (64.34 Ibs/ac)
B Nitrate (21.34 lbs/ac) |NITR -> Applications: Ammonia, Nitrate, Organic N

Organic N (47.48 Ibs/ac)

NITR -> State Variables - Storages by Layer >
Totals: Plant N

NITR-> State Variables - Storages by Layer >
Upper Principal: Plant N

C 106.83 Ibs/ac

D 80.16 Ibs/ac
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Question Answer Answer Location
E 2847 Ibs/ac NITR-> State Variables - Storages by Layer >
Totals: Total N
NITR-> Below-Grnd NO3 Uptake = Orgn
F 35.58 lbs/ac Mineralization: Total TORNMN
G Lower Zone NITR-> Below-Grnd NO3 Uptake - Orgn
(21.67 Ibs/ac) Mineralization: LORNMN

Next, we will open the summary reports generated during the simulation to verify the results
shown in the standard output and to illustrate the difference in the output formats. The
summary reports include the nitrogen and phosphorus fluxes for each PERLND for each

year, as well as the average fluxes for the simulation period. The reports also include

simulation results for mineralization, plant uptake by soil zone, runoff by layer and type

(NHs, NOs, etc.), and

nitrification.

3. Using My Computer or Windows Explorer, navigate to c:\basins\modelout\agchem.
Right click “PU_300.rpt” and select Open With - WordPad. The Plant Uptake
report will open.

4. Look through this report. Notice that the simulated nitrogen plant uptake for the
upper zone in 1986 is 79.015 Ibs/acre. This is the same value that was found in the
output file (see question D in step 2).

B Pu_300.rpt - WordPad

File Edit Wiew

Insert Format  Help

=[5

s ETE e RN

HIGH-TILL

Upper Zone Plant  |eno
Nitrogen Uptake

Nitrogen Upper
Nitrogen Lowe
trogen al

PLANT UPTAEE

CROP -310

Plant Uptake (lb/acre)
Nitrogen
Nitrogen Surface

Phorus Surfac
josphorus Upper
sphorus Lower
Phosphorus Total

1956

106.83

0.058
10.405
4.120
14.583

1987

inlenlaliel 0.006
§0.159 78,790
= 28.497

107.29

0.10z
13.438
4. 689
15.z2z29

1988

0.009
G0. 444
24.859
108.31

0.o77
10.565
3.917
14.559

Iverage

0.007
79,798
26.673
106.48

0.o0ve
11.469
4.242
15.750

|»

<

PLANT UFTAEE
LOW-TILL CROP -311

Plant Uptake (lb/acre)
Nitrogen
Nitrogen Surface
Nitrogen Upper

1956

0.00z

76.158

1987

0.00z
69.804

1988

0.00z2
72.957

Average

0.00z
72.973

For Help, press F1

5. Close PU_300.rpt.

6. Open the other reports (all the *.rpt files).
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step 2 using the reports.

Recall from the AGCHEM lecture that when modeling nutrients, there are two main
components of nutrient balances: sources/inputs (adding nutrients to the system) and
losses/outputs (immobilizing or taking nutrients from the system). Key nutrient source
processes for agricultural land include nutrient applications of fertilizers and manure,
atmospheric deposition, as well as mineralization of soil organic nutrients. Key removal
processes for agricultural land include plant uptake and (to a lesser extent) immobilization.
In the following sections, you will become more familiar with the sensitivity of parameter
inputs on nutrient fluxes by adjusting key parameters, running the model, and examining
output to determine the effects on the simulation.

B. Nutrient Losses (Outputs)

QUESTIONS ANSWERED:

3) What are some important nutrient loss processes with respect to agricultural land?
4) Which parameters are important for modeling plant uptake?

Plant Uptake

Plant uptake is a process by which chemicals in the soil can be extracted from the pool of
inorganic nutrients available for runoff and leaching. Because plants can take up nitrogen
and phosphorus in large quantities and significantly affect processes such as runoff and
leaching, it is important to effectively model plant uptake. In the following steps, we will
examine the effects of adjusting key plant uptake parameters.

1. From the Start menu under Programs, select BASINS and then WinHSPF.

2. Navigate to c:\basins\modelout\agchem and select “wb_agchm.uci”

Before we make parameter adjustments, we will look at plant uptake plots for both nitrogen
and phosphorus in GenScn.

Note: The output for this model has already been specified. You can view the output

locations by clicking the Output Manager button, rE: and then clicking the
button beside “Other.” The Output Location list will look similar to the
following:

11-4



BASINS/HSPF Training Exercises

4. Click

6. Click

Output Locations:

M ame | Description | GroupMember -
FERLMD 210 HIGH-TILL CROP MITH:5M

FERLMD 310 HIGH-TILL CROP MITR:UM

FERLMD 210 HIGH-TILL CROP MITR:LM

FERLMD 210 HIGH-TILL CROP MITR:TH

FERLMD 310 HIGH-TILL CROP PHOS:5P ﬂ

Notice the constituents listed for PERLND 310 and PERLND 311. These
constituents represent the amounts of nitrogen and phosphorus in the soil by
layer. For example, NITR:UN is the amount of nitrogen in the upper layer of
soil. For these constituents, there are several output options. Each constituent
has a set of several subscripts ([1,1], [2,1]... [8,1]), representing the
alternative forms of nitrogen. The HSPF Manual (c:\basins\docs\hspf.chm)
lists the subscripts and explains what they represent for each section (NITR
and PHOS). We selected NITR:SN(5,1), NITR:UN(5,1), NITR:LN(5,1), and
NITR:TN(5,1) for the nitrogen plant uptake variables and PHOS:SP(4,1),
PHOS:UP(4,1), PHOS:LP(4,1), and PHOS:TP(4,1) for phosphorus plant
uptake variables. The constituents are named according to the following
convention:

Name Constituent
SN |Nitrogen in surface layer storage (Ib/ac)
UN |Nitrogen in upper layer principal storage (Ib/ac)
LN |Nitrogen in lower layer storage (Ib/ac)
TN |Total nitrogen in soil
SP  |Phosphorus in surface layer storage (Ib/ac)
UP  |Phosphorus in upper layer principal storage (lb/ac)
LP |Phosphorus in lower layer storage (Ib/ac)
TP [Total nitrogen in soil

Close the Output Manager if you opened it.

1 (Run HSPF).

Click SAVE/RUN.

ﬁ (View Output through GenScn).

Click the “HSPF Output” tab and select c:\basins\modelout\wb_ag.wdm. Click OK.

GenScn will open.

In the “Locations” frame, select “PER 310.”
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0. In the “Scenarios” frame, select “WB_AGCHM.”
-l

File Analysis Map Locations Scenarios  Constituents  Time Series  Help

— Locations —Scenarios—— | [ Constituents ——————————————
1 of 25 All I Nnnel 1of4 All | Nunel D of 34 All | Nune'
cunk> i« All " Location @ All " Location
BATTIMOE ATMOSDEP ANH4 -
BELTSVIL BASE AND3
N OBSERVED ATMP
BWI WH AGCHM BODS
BWI-AP LHLA
CLARKSWL DEWP
DAMASCUS DO
DULLES EVAP
HIGHTILL FLOW
HUNTING HPCP
KILLPECK LN
LAUREL LP
LOWTILL NH4x
MARLEORD NOZX
MECHANIC ORGN
PATUXENT ORGP :I
PATXRIY
PER 310
ROCKY-G — Time Senes [0 of 33E)
SAYAGE =
TRIADELP +—[%] 2[4]¥] = Bl A Nonel
UNITY
WASH-DC | |

10. Click the “Add to time series list” button, + The “Time Series” list should look
like the following:

— Time Senes [8 of 336]

+H—|%| 2[4]¥] F| H©| oA Honel

Type |File  |DSM|Scenaio | Location | Constituent| Start |
WO wh_ag 1084 WEB_AGCHM PER 310 SN 1936/1.1
WM wh_ag 1085 WEB_aGCHM PER 310 UM 19864141
WM wh_ag 1086 WB_&GCHM PER 310 LN 19864141
WO wh_ag 1087 WEB_AGCHM PER 310 TN 1936/1.1
WM wh_ag 1092 WB_aGCHM PER 310 SP 1986411
WM wh_ag 1093 WB_aGCHM PER 310 UP 19864141
WO wh_ag 1094 WB_&GCHM PER 310 LP 1936/1.1
WM wh_ag 1095 WB_AGCHM PER 310 TP 19864141

11. Hold down the SHIFT key and click on the timeseries corresponding to SN, UN, LN,
and TN. These contain values for plant nitrogen uptake for the surface, upper layer,
lower layer, and total uptake, respectively.

— Time Sernes [8 of 436)

H=[] 2|44 5 Bl o] A Lo

Type |Fi DSH | Scenario Location | Constituent | Start

CH 1
_AGCHM PER 310 5P 198641,

wh_ag 1192 ‘WE
WwhM wh_ag 1193 WEB_AGCHM PER 310 UP 19861,
‘WDM wh_ag 1194 WE_AGCHM PER 310 LP 198641,
WDM wh_ag 1195 WE_AGCHM PER 310 TP 19861,
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12.  Click the “Generate Graphs” button, 'lIII

13.  Click GENERATE. Your plot should look similar to the following:

150

120

o
(==

SN, UM, LW, TH

30

— &H
— H
— LH
— TH

F 4

I A o0 D F & T A O DI F Ao T

1926 1047 10as

WE_AGCHM ot PER 310

Ir

14.  Toggle to GenScn (don’t close the above plot).

15.  Hold down the SHIFT key and click on the times series corresponding to SP, UP, LP,
and TP. These contain values for plant phosphorus uptake for the surface, upper
layer, lower layer, and total uptake, respectively.

16. Click the “Generate Graphs” button, 'IIII

17.  Click GENERATE. Your plot should look similar to the following:

— Time Sernies [B of 436)

%] 2[41¥] F| 0| A None|

Type |File  |DSM |Scenaio | Location | Constituent | Start
WOM wh_ag 1184 WB_AGCHM PER 310 SH 198641,
WM wh_ag 1185 wWEB_AGCHM PER 310 UM 198641,
WOM wh_ag 1186 WEB_AGCHM PER 310 LM 198641,
198641,

WOM wh_ag 1187 WEB_AGCHM PER 310 T

11-7



BASINS/HSPF Training Exercises

25

—
NpF—or1r

iy

|
¢
|
F & I 4 0 D‘ F & I 4 0 D| F 4 I & 0O D
1986 1987 1983
WE_AGCHM ot PER 310

—
Ln
I

|

—
=
I

3P, UF, LE, TP

Notice that plant nitrogen and phosphorus concentrations are reset to zero at the beginning of
each year. This is to represent crop-removal as a result of harvest practices, e.g. removal of
corn stalks for silage after harvest. If you want, you can change this to a more reasonable
harvest time (for example, October 15) in the SPECIAL ACTIONS block and assess the
impacts on the uptake curves. Since plant uptake is a state variable, defined as the nutrient
amount taken up by the plants from each soil layer, it will continually increase until some
type of intervention, such as harvest operations, resets this value so that it will begin to
accumulate as the subsequent year crop begins to grow again. There are more detailed
nitrogen cycling options within the NITR module for the return of forest and crop residues
and litter to the soil (See the HSPF Manual), but these are not activated in this simple
example.

Notice that for both nitrogen and phosphorus, the surface uptake (SN and SP, respectively) is
essentially zero. This is because there is very little moisture in the surface soil layer except
during runoff events, and plant uptake is derived only from the soluble inorganic forms; for
the surface layer these forms are essentially zero except during storm events. Thus, plant
uptake occurs primarily from the upper zone and lower zone, which retain moisture and
soluble nutrients. These constituents can also be extracted from groundwater (the model
allows this pathway), but for most agricultural conditions, the rates that control this are
usually set to zero — most crops will not survive under extended saturated soil conditions.

18.  Close the plot(s) and the “Graph” window.

19. Exit GenScn and return to WinHSPF.

To help you understand the impact plant uptake rates have on the model, we will double the
plant uptake rates for both nitrogen and phosphorus for each layer and then run the model

and plot the results.

Before we adjust the uptake rates, we will create another project file for this scenario
(doubling the plant uptake rates for each layer). After we have run the scenario, we will
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return to our original input file (wb_agchm.uci) to run other scenarios.
20. From the File menu, select Save As.
21. Enter “ag_uptak” as the “New Project” name.

22.  Click OK,

23.  Click H (Input Data Editor).

24. Double click PERLND = NITR - MON-NITUPT. The following table will appear:

# _Edit PERLND:MON-NITUPT -10O| x|
v Show Description Ccourence |-| vl

OpMum| Description | EPLJAM| KPLFEB| KPLMAR| KPLAPR| KPLM&Y| KPLIUN| KPLIUL| KPLAUG| KPLSER| K
310 HIGH-TILL CROP 0 0 0 033 05 0B 0B 06 05
311 LOW-TILL CROP 0 0 0 003 016 018 018 017 016

Note: Notice the “Occurrence” menu at the top of the screen. Occurrences 1, 2, and 3
correspond to the surface, upper, and lower layers respectively. We will
double the uptake rates for each layer (occurrence).

Note: We are entering monthly values for plant uptake because the uptake rates vary
greatly by month (e.g., little or no uptake occurs during winter months).

25. Make sure the “Occurrence” is “1” (for the surface layer). Change the monthly
values for PERLND 310 and PERLND 311 to the following:

OpNum | Description | Jan | Feb |Mar| Apr|May| Jun | Jul | Aug| Sep | Oct | Nov | Dec
310 High-till crop | 0 0 0 [0.66]1.14]1.38]1.38] 1.3 |1.14]0.42
311 Low-till crop | O 0 0 [0.18/0.32{0.36/0.36/0.34/0.32/0.02] 0 | O

o
o

26. Click APPLY.

217. From the “Occurrence” list, select “2” ( for the upper layer). Change the values to the
following:

OpNum | Description | Jan | Feb |Mar| Apr [May| Jun | Jul |Aug| Sep | Oct | Nov | Dec
310 High-till crop | 0 2.18]5.06/11.6]20.2/20.2|17.3|11.6[1.46
311 Low-tillcrop | O | O | O |0.56]1.34/3.06/5.38/5.38| 4.6 |0.06] O | O

o
o
o

28. Click APPLY.

29. From the “Occurrence” list, select “3” (for the lower layer). Change the values to the
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following:

OpNum | Description | Jan | Feb |Mar| Apr [May| Jun | Jul |Aug| Sep | Oct | Nov | Dec

310 High-till crop | 0 1.38] 29 (7.22|11.6]11.6(9.38|6.52|0.72

o
o
o

311 Low-tillcrop | O | O | O |0.36/0.76/1.92/3.06/3.06| 2.5 |0.04] O | O

30.

31.

32.

33.

34.

35.

36.

37.

38.

39.

40.

41.

42.

Click APPLY.

Click OK.

Double click NITR to contract the list.
Double click PHOS - MON-PHOSUPT.

Make sure the “Occurrence” is “1.” Change the monthly values for PERLND 310
and PERLND 311 to the following:

OpNum| Description | Jan | Feb |Mar| Apr |[May|Jun | Jul |Aug| Sep | Oct | Nov | Dec
310 |[High-tillcrop| 0 | 0 | O | 6.2 ]11.8/13.8|/16.6/16.6|13.8 0.2
311 |Low-tillcrop| O | O | O |12 |46 |72|72|58[52| 0| 0| O

©
o

Click APPLY.

From the “Occurrence” list, select “2.” Change the values to the following:

OpNum | Description | Jan | Feb |Mar | Apr [May|Jun | Jul |Aug| Sep | Oct | Nov | Dec

310 |High-till crop| 0O 84 11.8|14.6|16.6| 18 | 18 |13.2

o
o
N
o

311 | Low-till crop| O 0 0 | 78] 11 136|156 17 | 17102 O 0

Click APPLY.

From the “Occurrence” list, select “3.” Change the values to the following:

OpNum | Description | Jan | Feb |[Mar| Apr |[May|Jun | Jul |Aug| Sep | Oct | Nov | Dec

o
o
()
o

310 |High-till crop| 0O 1248|7676 62|56 |34

311 |Low-till crop| O 0 0 | 58] 11| 13 |15.6]156] 13 |02 | O 0

Click APPLY.
Click OK.
Click CLOSE.

Following steps 4 -17 in this section, run the model and graph the plant uptake curves
for nitrogen and phosphorus.
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Note: When GenScn opens, you will see that there are several options in the

“Scenarios” frame. To view the results of the scenario you just simulated
(doubled plant uptake rates), select “PER 310 in the “Locations” frame, and
“AG_UPTAK?” in the “Scenarios” frame. Graph the timeseries for nitrogen
and phosphorus.

Your plots should

look similar to the following:

lju|||||||||||||||||||||||||||||||||||
— 54
wo | T
— TH
Z et
Enﬁn—
=
5
= ol
= 4n
|
DI)IIIIIIIIII||||||||||||||||||||
F & I & o0 D| F & T A O D/ F &4 T & 0O D
1936 1987 19583
A UPTAK i PER 310
2j|||||||||||||||||||||||||||||||||||
—3p
— 1
W-—r1p 7
;15- .
"
= 1wl _
[n Y
L |
{
DII||||||||||||||||""|Im
FP..TAIIID|FA.TADD|FA.TADD
1956 1087 1088
AR UDTAK s DER 310

The plots indicate that doubling the plant uptake rate increased the plant storage of both
nitrogen and phosphorus. To better examine the differences between these plots and those

you created in the previous simulation, we will plot the results from both simulations
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together.
43.  Toggle to GenScn.
44, In the “Locations” frame, make sure “PER 310" is selected.
45, In the “Scenarios” frame, select “WB_AGCHM” and “AG_UPTAK.”
46. Click the “Add to time series list” button, +
47. Select the timeseries that correspond to WB_AGCHM and AG_UPTAK for SN, UN,
LN, and TN (you will select a total of eight timeseries):
— Time Series [16 of 636)
+H—[ 2[4]¥] & & |@pz.u" Hone|
_ GCHM PER 310 5P 1aE_|
WDM wh_ag 1193 WE_AGCHM PER 310 UP 13
WwDM wh_ag 1194 WE_AGCHM PER 310 LP 19
WOM wh_ WB_AGCHM PER 310 TP 19
m-
UP E
mmmmmn_m_l
48.  Click 'llll (Generate Graphs).
49.  Click GENERATE. Your plot should look similar to the following:
125IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
— WE_AGCHM SH
g ]
En
=
D. -
&
DIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
FAJADD‘FRJADD‘F&J.&DD
1286 1287 1988
Anatesis Plot for o PER 310
50.  Select the timeseries that correspond to WB_AGCHM and AG_UPTAK for SP, UP,
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LP, and TP (you will select a total of eight timeseries):

— Time Senes [16 of 636)

+|—% 2[4|¥| | B L] Hone

Location | Constituent | 5ta

310

GEHM | P

AK. PER 310 5N 138
PER 310 UN 138

PER 310 LN 138

51.  Click 'Illl (Generate Graphs).

52. Click GENERATE. Your plot should look similar to the following:

a5

rT 1T 1T 11171717171 1T T TT T T T T T TTTTTTTTTTTTTT
— WE_AGCHM ST

an

I T N Y e |
FAIADD|FAJRDD|FAIADD

1926 1027 1o2a
Dmabyesic Plat for «f PER 310

Examine the plots. Doubling the uptake rates appears to have had a more pronounced affect
on the phosphorus storage than the nitrogen storage, even considering the large difference in
the total uptake, with nitrogen approaching 110 Ib/ac and phosphorus about 20 Ib/ac. Plant
uptake is controlled by the amount of inorganic nutrient in soluble form available to the plant
in each soil layer. Since nitrogen must undergo other processes (e.g. nitrification,
denitrification, volatilization) controlling its availability to the plant, actual plant uptake may
have been limited by the available storage. Examine the AGCHEM output to see if this is a
plausible explanation.

53.  Close all plots, the “Graph” window, and GenScn. Return to WinHSPF.
Immobilization

Immobilization is the conversion of inorganic nutrients (NH3, NO3, PO4) to organic
material. Most organic material is bound tightly to soil, and therefore relatively immobile.
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Because immobilization does not significantly affect our simulation, we will not adjust any
parameters related to this process in this exercise. In your own applications, you should look
at the KIMNI and KIMAM for nitrogen and KIMP for phosphorus, to assess the potential
impacts of immobilization on the nutrient balances. It will tend to reduce inorganic nutrient
concentrations and may be used to reduce this form in the runoff components.

C. Nutrient Sources (Inputs)

QUESTIONS ANSWERED:

5) What are some important nutrient sources with respect to agricultural land?
6) Which parameters are important for modeling mineralization?

7) How can | adjust the amount of atmospheric deposition in my model?

Mineralization

Mineralization is the process in which organic matter is converted to inorganic products. For
nitrogen, it is also often called ammonification. It is important in modeling nutrients because
when organic matter is broken down into inorganic components, nutrients become available
for plant uptake, runoff and leaching.

In this section, we will adjust the mineralization rates and assess the impacts by running the
scenario and plotting the results. We will create a new project for this scenario based on our
original wb_agchm.uci file.

1. In WinHSPF, from the File menu, select Open. The following window will appear:

:_ UCI Open Y¥arning El

Only one UCI can be active at a time.
Continuing will deachivate the current UCL.
Are you sure you want to continue?

Cancel |

2. Click OK.

3. Navigate to c:\basins\modelout\agchem. Select “wb_agchm.uci” and click OPEN.
4. From the File menu, select Save As.

5. Enter “ag_min” as the “New Project” name and click OK.

Before we make parameter adjustments, we will look at the output file to determine which
layers contribute most to mineralization.
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6. Using My Computer or Windows Explorer, navigate to c:\basins\modelout\agchem
and double click “ag_min2.out.”

7. Scroll down to the “NITR” section and look at the ORGN MINERALIZATION data.
Notice that the greatest amount of mineralization occurs in the upper and lower

layers:

-GEND NO3 PLANT UPTLEE SURFACE TPPER PRIN LOWER ACTIVE GW TOTAL
SMNIUPE THNIUFPE LNIUPE ANITPE THIUFE
Z.407E-03 7.161E+01 Z.511E+01 0.000E+00 9.673E+01
DENITRIFICATICHN SURFACE UFFEE PRIN LOWER ACTIVE GW TOTAL
SDENI TDENI LDENI ADENI TDENI
0. 000E+00 Z.544E-01 1.099E+00 1.258E+00 Z.611E+00
NH3 NITRIFICATICH SURFACE TPFER FRIN LOWER ACTIVE G TOTAL
JLILT o —— LAMNIT LAMMIT TAMNIT
2 1.558E+01 Z.979E-01 G.601E+01

Lower layer nitrogen
NH3Z IMMOEILIZATICN 1 1 1 LOWER ACTIVE G TOTAL
mlnerallzatlon LAMINE LANIME TALMIME
L OSoE-11 1. J00E+0T 4.013E-01 0.000E+00 1.552E+01
QRGN MINERALIZATICH SURFACE TPFER FRIN LOWER ACTIVE GW TOTAL
SORNMI TTORMNMI LORNMIT AORNMI TORNMI
5.Z68E-01 1.139E+01 .167E+01 0.000E+00 3.358E+01
NO3 IMMOEILIZATICN SURFACE UFFEE PRIN LOWER ACTIVE GW TOTAL
ZNIIME THNIIME LNIINE ANIIME THNIIME
0. 000E+00 0. 000E+00 0. 000E+00 0. 000E+00 0. 000E+00

8. Scroll down to the “PHOS” section and look at the ORGP MINERALIZATION data.
Notice that, as with nitrogen, the greatest amount of phosphorus mineralization
occurs in the lower layer:

Lower layer phosphorus

PO4 TMMOEILIZATICHN EY LAYER mineralization LOWER ACTIVE GW
LF4IME AP4IME

1.084E-01 4.257E+00 \ 3.565E-01 0. 000E+00

CRGPF MINERALIZATICH EY LAYER SURFACE UPFER FRIN LOWER ACTIVE GW
JORPMI TORPMI LORPMI AORPMI

Z.227E+00 3.0ZZ2E+00 3.892E+00 0. 000E+00

Note: Scroll to the right to look at the totals for mineralization.

The soil layer distribution of nitrogen and phosphorus mineralization for 1986 is as follows:

Layer Nitrogen |Phosphorus
Surface 0.53 2.23
Upper Principal 11.39 3.02
Lower Layer 21.67 3.89
Active Groundwater, 0.00 0.00
Total 33.58 9.14
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9.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22,

23.

24,

25.

Close the output file and return to WinHSPF.

Click H (Input Data Editor).

Double click PERLND = NITR = NIT-FSTPM.

Note: Notice the “Occurrence” list at the top of this table. Occurrences 1, 2, 3, and 4
correspond to data for the surface, the upper principal, the lower layer, and
active groundwater, respectively.

Make sure the “Occurrence” is “1.” Change each value of KAM to “0.002.”

Note: KAM is the parameter value for organic nitrogen ammonification
(mineralization).

Click APPLY.

From the “Occurrence” list, select “2.”

Change each value of KAM to “0.0004.”

Click APPLY.

From the “Occurrence” list, select “3.”

Change each value of KAM to “0.0004.”

Click APPLY.

Click OK.

Double click NITR to contract the list.

Double click PHOS - PHOS-FSTPM.

Make sure the “Occurrence” is “1.”

Change the value of KMP to “0.02” for PERLND 310.
Change the value of KMP to “0.016” for PERLND 311.

Note: KMP is the first order reaction rate for organic phosphorus mineralization.
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26. Click APPLY.

27.  From the “Occurrence” list, select “2.”

28.  Change the value of KMP to “0.0004” for PERLND 310.
29.  Change the value of KMP to “0.0001” for PERLND 311.
30. Click APPLY.

31.  From the “Occurrence” list, select “3.”

32.  Change the value of KMP to “0.001” for PERLND 310.
33.  Change the value of KMP to “0.0012” for PERLND 311.
34. Click APPLY.

35. Click OK.

36.  Click CLOSE to exit the Input Data Editor.

Next, we will run this scenario, plot the results, and look at the output file to evaluate the
impacts of doubling the mineralization rates.

37. Run HSPF and plot the new uptake curves (Scenario = AG_MIN) with the uptake
curves you created before doubling the mineralization rates (Scenario =
WB_AGCHM). Your plots should look similar to the following:

150

SH, UN, LN, TH

i . N ™ - Y
F A T & 0O D| F A I A& 0 Dl F & T & 0 D
1956 1957 1933

HAratyeis Dlot for  PER 310
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38. Using My Computer or Internet Explorer, navigate to c:\basins\modelout\agchem and

open “wb_agchm2.out.” The new components of nitrogen and phosphorus

mineralization for 1986 are as follows:

Compare these values to those generated before doubling the mineralization rates:

Both the nitrogen and phosphorus mineralization values for 1986 were significantly

Layer Nitrogen |Phosphorus
Surface 1.08 4.36
Upper Principal 22.59 5.97
Lower Layer 42.95 7.54
Active Groundwater 0.00 0.00
Total 66.62 17.87

Layer Nitrogen |Phosphorus
Surface 0.53 2.23
Upper Principal 11.39 3.02
Lower Layer 21.67 3.89
Active Groundwater 0.00 0.00
Total 33.58 9.14

increased. Increasing the mineralization rates makes more inorganic nutrients available to the
crop for subsequent plant uptake, and thereby reduces the amount of additional nutrients
needed by the crop from fertilization.

39.  Close the output file and return to WinHSPF.
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Atmospheric Deposition

The most important external sources of nutrients are fertilizer/manure applications and
atmospheric deposition.

According to the Maryland Department of Natural Resources, atmospheric deposition is “the
process, long recognized by scientists, whereby precipitation (rain, snow, fog), particles,
aerosols, and gases move from the atmosphere to the earth's surface. Materials reaching the
earth in precipitation or as dry deposition originate from a variety of air pollution sources and
can be harmful to the environment and public health. Acidic deposition is the most widely
acknowledged form of atmospheric deposition, with well-known effects on lakes, streams,
and forests. More recently, atmospheric contributions of nutrients have received increasing
attention, particularly as a source of excessive nitrogen entering the Chesapeake Bay. In
addition, atmospheric deposition may be a significant source of environmental contaminants
such as trace metals and toxic organic compounds” (Maryland Streams, 2003).

Input time series can added to HSPF to aid in the simulation of atmospheric deposition of
quality constituents. Atmospheric deposition inputs can be specified in two possible ways
depending on the form of the available data. If the deposition is in the form of a flux (mass
per area per time), then it is considered dry deposition. If the deposition is in the form of a
concentration in rainfall, then it is considered wet deposition, and the program automatically
combines it with the input rainfall time series to compute the resulting flux. Either type of
deposition data can be input as a time series, which covers the entire simulation period, or
alternatively, as a set of monthly values that is used for each year of the simulation. The
specific atmospheric deposition time series for each operational module (PERLND,
IMPLND, RCHRES) are documented in the EXTNL table of the Time Series Catalog for
that module (HSPF Manual, 2001).

In the following steps, we will increase the multiplication factor for the atmospheric
deposition time series, and then plot the uptake curves for nitrogen to assess the effects.

1. In WinHSPF, from the File menu, select Open. The following window will appear:

i_ UCT Open Warning 5'

Only one UCI can be active at a ime.
Continuing will deactivate the current LICI.
Are you sure you want to continue?

Cancel |

2. Click OK.

3. Navigate to c:\basins\modelout\agchem. Select “wb_agchm.uci” and click OPEN.
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4, From the File menu, select Save As.

5. Enter “ag_atdep” as the “New Project” name.

6. Click m (Input Data Editor).

7. Double click EXT SOURCES. The following window will appear:

'___ Edit EXT SOURCES Block = |E
YolMame | Volld| MemMame | OFlag| 55 ystem | SoapSt | MultFact] Tran | YolName | Yolld| Group | MemName | MemSubl| MemSub2
WD 105 HPCF 10 ENGL 0a PERLMD 302 ExTHL FREC 1] 1]
WD 122 ATMP 10 EMGL 1 FERLMD 302 ExTHL GATMP I I
WD 111 EvaP 10 ENGL 08 Ol PERLMD 302 ExTHL PETINF 1] 1]
WOk 105 HPCF 10 EMGL 0.8 FPERLMD 306 EXTML FREC 0 0
WD 122 ATMP 10 EMGL 1 PERLMD 306 ExTML GATMP 1] 1]
WOk 111 EVaP 10 EMGL 0.8 ons PERLMD 306 EXTHML PETIMP 0 0
WDk 105 HPCF 10 EMGL 0.s FERLMD 307 ExTML PREC 1] 1]
WwDd 122 ATMP 10 EMGL 1 PERLMD 307 EXTHML GATHMP 0 0
Wk 111 EvaP 10 EMGL 08 Ol PERLMD 307 ExXTHL PETIMNP I I
WwDd 801 AMOD3 10 EMGL 1 FERLMD 310 EXTHL MIADFS 1 1
Wk a0z AMH4 10 EMGL 1 FERLMD 310 ExTHL MIADF= 2 1
WD 105 HPCF 10 ENGL 0a PERLMD 310 ExTHL FREC 1] 1]
THEMSZ: Target member name second subscript.

8. Double click the cell that corresponds to PERLND 310, ANO3, and MultFact.
Change the “MultFact” to “1.3.”

9. Double click the cell that corresponds to PERLND 310, ANH4, and MultFact.
Change the “MultFact” to “1.3.” Your EXT SOURCES block should look like the
following:

YolMame | Yolld| MemName | OFlag| S5ystem | SoapSte | MultFact| Tran | WolMame | Yolld| Group | Membame |
WDk 105 HFCP 10 EMGL 08 FERLMD 302 ExTHL FREC
WDk 122 ATMP 10 EMGL 1 FERLMD 302 EXTHL GATMP
WDk 111 EVAP 10 EMGL 0.8 DI FERLMD 302 EXTHL PETIMP
WM 105 HPCP 10 EMGL IR:] FERLMD | 306 EXTHML PREC
WM 122 ATMP 10 EMGL 1 PERLMD | 306 EXTML GATMP
WM 111 EVaP 10 EMGL 0.8 D PERLMD | 306 EXTML PETIMP
WM 105 HPCP 10 EMGL 0.8 PERLMD | 307 EXTHML PREC
WM 122 ATMP 10 EMGL 1 PERLMD | 307 ExTML GATMP
WM 111 EVAP 10 EMNGL 08 DI PERLMD | 307 ExTHML PETIMP
WDk 801 AND3 10 EMGL 1.3 FERLMD 310 EXTHL  MIADF
WDk 802 ANH4 10 EMGL 1.3 FERLMD 310 EXTHL  MIADFX
WM 105 HPCP 10 EMGL [IR:] FERLMD | 310 EXTHML PREC

10. Click APPLY.

11. Click OK.

Note: There is not a phosphorus deposition time series for this project file.
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12. Click CLOSE to exit the Input Data Editor.

13. Run HSPF and plot the new nitrogen uptake curves (Scenario = AG_ATDEP) with
the original nitrogen uptake curves (Scenario = WB_AGCHM). Your plot should
look similar to the following:

L I I e B
— WE_4LHGCHM SH

SH,UH,LH, TH

i . I S . .
F & I & 0 DI F & T &4 0O DI F & T & 0O D

1986 1087 1088
Arateeic Plat for &t PER 310

The plant uptake storage increased slightly with an increase in atmospheric deposition. This
is to be expected since there are now more nutrients available for uptake. However, the
increase is small because the amount available from atmospheric deposition is small
compared to normal agronomic fertilizer/manure applications.

14.  Close your plot(s), the “Graph” window, and GenScn.
Fertilizer Application

An additional use of these atmospheric deposition time series is the specification of
agricultural chemical and fertilizer inputs to the soil. These input time series provide an
alternative to the SPEC-ACTIONS block as a means for changing soil storages of chemicals
in the AGCHEM sections of the program. For this purpose, "deposition™ to the upper soil
layer in addition to the surface soil layer is available in PERLND sections NITR, PHOS, and
TRACER.! Depending on the complexity of the agricultural practices being modeled, the
user should decide whether the SPEC-ACTIONS or the time series inputs are simpler to
construct (HSPF Manual, 2001).

1 Section PEST has time series only for the surface layer, since most pesticides are not normally incorporated
into the soil as fertilizers are. However, for soil fumigants and similar compounds SPECIAL ACTIONS can be
used; this is the preferred method for specifying chemical applications due to the wide range of options
available.
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Note: Because of time constraints, we will not adjust the fertilizer application rates.
If you wish, you can adjust these rates in the SPEC-ACTIONS tables and
assess the effects.

D. Additional Exercises

This exercise has been an introduction to AGCHEM. If you have time (and interest), you
may want to try the following:

e Use WInHSPF to change tillage practices, fertilizer timing and placement, etc.

e Use the yield-based algorithm for plant uptake and compare with first-order rates.

e Convert the forest segment to the more detailed AGCHEM nitrogen cycling algorithms,
which include many more parameters and processes (e.g., above and below ground plant
nitrogen, litter layer compartment, return of plant residues to the soil, etc.).
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